Instaliranje i podesavanje
AutoCAD-a

U ovom dodatku govorimo o nacinu instaliranja AutoCAD-a 2006 i o sistemskim para-
metrima koje bi trebalo definisati da biste AutoCAD podesili tako da vam odgovara.
Sistemske promenljive koje su u vezi s nekim parametrom (kada su dostupne) date su
na kraju opisa opcije, u zagradama. To su parametri pomocu kojih odredujete kako ce se
AutoCAD ponasati pri koris§¢enju raznih komandi i osobina. Sistemske promenljive su
detaljno opisane u dodatku C.

Pre instaliranja AutoCAD-a

Pre nego $to poc¢nete instaliranje, morate imati barem 500 MB slobodnog prostora na
disku na kome cete instalirati AutoCAD. Potrebno je jo§ i 100 MB slobodnog prostora za
AutoCAD-ove privremene datoteke i datoteke za razmenu podataka (engl. swap files),
zatim jo$ 20 MB za datoteke koje cete praviti tokom obuke. Ukoliko instalirate AutoCAD
na disk na kome nije instaliran Windows, proverite da li imate barem 220 MB slobodnog
prostora na disku na kome je Windows. AutoCAD tamo ¢uva priviemene datoteke.

Takode treba da imate Windows 2000 sa servisnim paketom 4 ili XP (verziju Home,
Professional ili Tablet), Internet Explorer 6 sa servisnim paketom 1, racunar sa proce-
sorom Pentium III na 800 MHz ili brZim, najmanje 512 MB RAM-a i graficku karticu koja
podrZava rezoluciju 1024 x 768 u punom koloru.

Imajte pri ruci ime i telefonski broj prodavca jer se ti podaci upisuju tokom instali-
ranja. Sistemi za jednog korisnika mogu se besplatno koristiti 30 dana, 3to znaci da
moZete instalirati i koristiti AutoCAD i pre nego $to unesete autorizacioni kod. Autoriza-
cioni kdd moZete da dobijete faksom, telefonom ili posredstvom Interneta, $to je nazna-
¢eno kada prvi put pokrenete AutoCAD.
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Postupak instalacije

AutoCAD 2006 se instalira kao i svaki drugi program za Windows, ali bi neke stvari tre-
balo da znate pre nego §to poc¢nete. Ovaj odeljak sadrzi podatke koji ¢e vam pomoci
kada zapocnete instalaciju.

Instaliranje AutoCAD-a

Instaliranje AutoCAD-a je jednostavno i jasno; AutoCAD koristi ¢arobnjake za instala-
ciju kao i veéina drugih Windowsovih programa. Naves¢u smernice koje treba da pratite
tokom procesa instalacije.

*

Pre nego Sto zapocnete instalaciju, proverite da li imate dovoljno praznog pro-
stora na disku i utvrdite da nisu pokrenuti drugi programi. Trebace vam i serijski
broj i CD klju¢ (obi¢no su oznaceni na pakovanju).

Obic¢no se instalacioni program AutoCAD-a pokrece automatski ¢im ubacite CD

AutoCAD 2006 u CD uredaj na racunaru. Ako se ne pokrene, ucinite sledece:

1. UWindowsu odaberite Start > Run da biste otvorili okvir za dijalog Run.

2. U polje Open upisite D:setup. Umesto slova D iz primera unesite slovnu oznaku
CD jedinice. Kada to zavrsite, pritisnite OK. Prikazuje se okvir za dijalog Auto-
CAD 2006 Master Setup.

Pri vrhu okvira za dijalog Master Setup nalaze se opcije: Install, What's Inside,

Documentation, Support i Network Deployment. Pritisnite Install. U okviru za

dijalog bice prikazane opcije za instaliranje. Pritisnite Install u okviru opcije

Install AutoCAD 2006.

Posto je instalacija pocela, pratite instrukcije ¢arobnjaka za instalaciju. U okviru za
dijalog Personal Information upisacete svoje ime, kompaniju za koju radite i ime

i telefon prodavca od koga ste kupili AutoCAD. Ti podaci se prikazuju na uvodnom
ekranu AutoCAD-a, pa savetujem da ih paZljivo unesete.

Takode se trazi da izaberete lokaciju za AutoCAD-ove datoteke. U vezbama u ovoj
knjizi pretpostavlja se da se AutoCAD nalazi na disku C u direktorijumu \Program
Files\AutoCAD2006\ - ta lokacija je predloZena tokom instalacije.

Modi ¢ete da birate izmedu Cetiri vrste instalacija: Typical, Full, Compact i Custom.
Savetujem da izaberete instalaciju tipa Full kako biste mogli da iskoristite sve
mogucnosti AutoCAD-a.

Ako nemate dovoljno prostora na disku, u prozoru ¢arobnjaka videcete tacno
koliko prostora treba da imate na svakom disku koji koristite tokom instalacije
AutoCAD-a. Upotrebom usluznih programa Windows Explorer i Windows Disk Cle-
anup, moZete napraviti viSe prostora na disku. Kada obezbedite potreban prostor i
pre nego §to se vratite u AutoCAD Setup, proverite da li ste zatvorili ove programe.

Po zavrSetku instalacije pojavice se okvir za dijalog AutoCAD 2006 Setup u kome se
traZi da ponovo pokrenete (restartujete) racunar, pa to i u€inite.
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Instaliranje ostalih komponenata AutoCAD-a

Ako niste na pocetku instalirali neke komponente AutoCAD-a, kao §to su alatke za rad
s bazama podataka a hocete da ih instalirate naknadno, sledite navedene korake:

1. Stavite CD sa AutoCAD-om 2006 u CD uredaj na racunaru.

2. Ukoliko se okvir za dijalog AutoCAD 2006 Master Setup ne pojavi automatski,
odaberite Start > Run da biste otvorili okvir za dijalog Run.

3. U polje Open unesite D:setup, gde je slovom D oznacen CD uredaj.

4. Odaberite opciju Install iz niza opcija na vrhu, a potom pritisnite Install u okviru
opcije Install AutoCAD 2006. Program za instalaciju otkrice da imate ve¢ instali-
ran AutoCAD na racunaru, tako da ¢ete moci da birate izmedu sledecih moguc-
nosti: da dodate ili deinstalirate neku od moguénosti AutoCAD-a, da ponovo
instalirate ili popravite AutoCAD 2006, ili da uklonite AutoCAD 2006 s racunara.
Izaberite opciju Add Or Remove Features i zatim pritisnite Next. Pojavice se okvir
za dijalog s listom opcija AutoCAD-a koje moZete instalirati.

5. S liste izaberite opciju koju hocete da instalirate. Pojavice se padajuci meni sa
skupom opcija za instalaciju. Odaberite odgovarajucu opciju.

6. Ponovite peti korak za svaku opciju koju Zelite da ukljucite u instalaciju Auto-
CAD-a. Kada zavrsite, pritisnite Next.

7. Na pitanje hocete li da nastavite instalaciju, pritisnite Yes da biste instalirali iza-
brane opcije.

AutoCAD-ove programske datoteke

U direktorijumu \Program Files\AutoCAD2006, nalazi se niz poddirektorijuma.
Evo kratkog opisa sadrZaja svakog poddirektorijuma:

Backup Sadrzi rezervne verzije mnogih AutoCAD-ovih sistemskih datoteka.

Data Links Lokacija datoteke Data Link za opciju dbConnect iz verzija AutoCAD-a
starijih od verzije 2004. U AutoCAD-u 2006 je sacuvana zbog kompatibilnosti sa sta-
rijim verzijama. Datoteke Data Link sada se smestaju u direktorijum C: \Documents
and Settings\korisni¢ko ime\Application Data\Autodesk\AutoCAD 2006\
R16.2\enu\Data Link.

Drv Sadrzi posebne pokretacke programe koje AutoCAD koristi za Stampanje na
ploteru i funkcije prikaza.

En-US Sadrzi izvorne datoteke za americku verziju AutoCAD-a. Verzije prilagodene
korisnicima iz drugih zemalja imaju drugacija imena direktorijuma.

Express Sadrzi datoteke s podrSkom za alatke Express.
Fonts Sadrzi fontove AutoCAD-a.
Help Sadrzi AutoCAD-ovu dokumentaciju za pomo¢.

Plot Styles Lokacija stilova Stampanja na ploteru za verzije AutoCAD-a starije od ver-
zije 2004. U AutoCAD-u 2006 je sacuvana zbog kompatibilnosti. Stilovi Stampanja na
ploteru sada se smestaju u direktorijumC: \Documents and Settings\korisnicko
ime\Application Data\Autodesk\AutoCAD 2006\R16.2\enu\Plot Styles.
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Plotters Lokacija konfiguracionih datoteka plotera za verzije AutoCAD-a starije od
verzije 2004. U AutoCAD-u 2006 je sacuvana zbog kompatibilnosti. Konfiguracione
datoteke plotera sada se smestaju u direktorijum C: \Documents and Settings\
korisnicko ime\Application Data\Autodesk\AutoCAD 2006\R16.2\enu\
Plotters.

Sample SadrZi primere crteza i ActiveX, DesignCenter, VBA i Visual LISP datoteke.

Support SadrZi datoteke s definicijama raznih AutoCAD-ovih funkcija koje se mogu
prilagodavati.

Template Lokacija Sablona za verzije AutoCAD-a starije od verzije 2004. U Auto-
CAD-u 2006 je sacuvana zbog kompatibilnosti. Sabloni se sada smestaju u direkto-
rijum C: \Documents and Settings\korisnicko ime\Application Data\
Autodesk\AutoCAD 2006\R16.2\enu\Template. To je takode ilokacija za Sablone
skupova listova.

Textures Lokacija datoteke sa teksturama za AutoCAD-ovo senc¢enje povrsina za
verzije AutoCAD-a starije od verzije 2004. U AutoCAD-u 2006 je sacuvana zbog kom-
patibilnosti. Datoteke sa teksturama sada se smestaju u direktorijum C: \Documents
and Settings\korisnic¢ko ime\Application Data\Autodesk\AutoCAD 2006\
R16.2\enu\Textures.

Tutorial SadrZi Autodeskove datoteke za ucenje.
UserDataCache Sadrziizvorne datoteke za korisnicke podatke.
WebDepot SadrZi datoteke tipa HTML za registraciju dok ste povezani na Internet.

WebServices Sadrzi datoteke za AutoCAD-ove Web servise, kao $to je Communica-
tion Center.

Ukoliko prilagodavate program, radite s datotekama iz direktorijumaC: \Documents
and Settings\korisni¢ko ime\Application Data\Autodesk\AutoCAD 2006\
R16.2\enu. Tu éete pronaci poddirektorijume Data Links, Plot Styles, Plotters i Support
koji rade s vasim korisnickim imenom u Windowsu. Ako postavite datoteke sa prilago-
denim parametrima u ovaj direktorijum, viSe korisnika mogu na istom racunaru da
imaju sopstvenu prilagodenu konfiguraciju.

Podesavanje AutoCAD-a

U ovom odeljku naucicete kako da podesite rad AutoCAD-a. AutoCAD moZete da pode-
site i tokom rada s programom, preko okvira za dijalog Options.

Vezbe u ovoj knjizi pripremljene su s pretpostavkom da upotrebljavate unapred pode-
Sene parametre Options. Kada bolje upoznate AutoCAD, moZete da podesite njegove
parametre preko okvira za dijalog Options. Mnoge opcije iz tog okvira mogu se podesiti
i preko sistemskih promenljivih.

Odaberite Tools > Options da biste otvorili okvir za dijalog Options koji sadrZi sle-
dece kartice i parametre.

SAVET  Mnoge opcije u okviru za dijalog Options prikazuju ikonicu AutoCAD-ove datoteke.
Ta ikonica govori da ce parametri opcije biti sacuvani s datotekom, a ne kao deo AutoCAD-
-ovih podrazumevanih parametara.
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Kartica Files

Pomocu opcija s kartice Files zadajete gde ¢e AutoCAD cuvati ili traziti datoteke koje su
mu neophodne za rad. Tu su hijerarhijske liste slicne onima iz Windows Explorera. Prvo
cete videti opste teme u listi Search paths, file names and file locations. Prikaz svake teme
moZete prosiriti ako pritisnete znak plus s leve strane.

Curnrent prafile; <¢Unnamed Prafilex» Current drawing: Drawingl.dwg

| Display | Open and Save | Flot and Fublish | System| User Freferences | Dratting| Selection | Prafiles |

Search paths. file names, and fils locations:
- & Support File Search Path = EBrowse..

[, Working Suppart File Search Path
[ Device Driver File Search Path

Project Files Seaich Fath Eemove

Custamization Files

Add...

-0 Help and Miscellaneous File Mames hove Up
E Text Editor, Dictionary, and Font File Names

L . . Hoye Dovm
- ﬁ Prirt File. Spooler. and Prolog Section Names

D) Printer Support File Path Sel Curent

[ Automatic Save File Location -
& Color Book Locations

[ Data Sources Location

-] Template Settings

) Tool Palettes File Lacations

m - [, Authoring Palstte File Locations LI

Specify the folders in which AutoCAD should look for text fonts, customization files, plug-ins,
drawings to insert, inetypes. and hatch patterns that are not in the curent folder.

oK I Cancel Epply Help

Sledi opis svih stavki iz liste. Verovatno vecinu njih necete koristiti, dok cete druge
menjati po potrebi.

SAVET  Sistemska promenljiva data je u uglastim zagradama, na kraju opisa svake stavke.

SUPPORT FILE SEARCH PATH
U mnogim svojim funkcijama, AutoCAD se oslanja na pomocne datoteke. Meniji, fontovi
za tekst, vrste linija, asocijativne $rafure, samo su neke od opcija koje sadrze pomocne
datoteke. Opcija Support File Search Path saopstava AutoCAD-u gde da trazi takve dato-
teke. Putanje za datoteke moZete dodati u liste tako Sto Cete pritisnuti taster Add i uneti
novu putanju ili ¢ete to uraditi pomocu dugmeta za pretrazivanje, Browse. Postojece
stavke nemoijte brisati ako niste sigurni da je ta odluka ispravna.

Ako umete da koristite promenljive za okruZenja, moZete i njih da ukljucite u putanje
pretraZivanja.

WORKING SUPPORT FILE SEARCH PATH

Sadrzi listu putanja na kojima AutoCAD trazi pomocne datoteke specificne za opera-
tivni sistem.

DEVICE DRIVER FILE SEARCH PATH

DefiniSe poloZaj upravljackih programa AutoCAD-a. Upravljacki programi (engl. device
drivers) jesu aplikacije koje omogucéavaju AutoCAD-u da komunicira sa Stampacima,
ploterima i ulaznim uredajima. U vecini slucajeva, te parametre ne treba da menjate.
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PROJECT FILES SEARCH PATH

Postoji mogucénost da od konsultanta ili od drugog korisnika AutoCAD-a dobijete dato-
teke koje sadrze reference na druge crteZe i rasterske slike. Obi¢no takve datoteke zahte-
vaju tacno odredeni direktorijum za Xref crteZe i rasterske slike. Ako ih premestite na
drugo mesto s razlic¢itim sistemom direktorijuma, one ne¢e moci da pronadu svoje refe-
rencirane crteZe. Opcija Project Files Search Path omogucava da zadate direktorijum za
Xref datoteke ili slicne zavisne datoteke. Ukoliko AutoCAD ne moZe da pronade Xref
datoteku ili neku drugu datoteku, potraZice je u direktorijumu koji ste zadali.

Da biste zadali taj direktorijum, odaberite opciju Project Files Search Path i pritisnite
dugme Add. AutoCAD ce predloziti da ime direktorijuma bude Project1. To ime mozZete
promeniti. Pritisnite znak plus pored polja u kome je upisano Project1 iizaberite
Browse da biste definisali putanju. Putanja se ¢uva u sistemskoj promenljivoj Project-
name [Projectname].

MENU, HELP, AND MISCELLANEOUS FILE NAMES

Ova stavka omogucava da definiSete razliCite datoteke podrske, kao §to su datoteke za
menije, pomo¢, automatsko snimanje, izlazak na mrezu i konfigurisanje. MoZete defini-
sati i Internet adrese kojima pristupate preko dugmeta Launch Browser sa standardne
palete alatki AutoCAD-a. Ukoliko imate mreZnu instalaciju, definiSite i lokaciju za
License Manager.

TEXT EDITOR, DICTIONARY, AND FONT FILE NAMES

Ovu stavku koristite za definisanje editora teksta [mtexted], korisnickih i standardnih
reCnika [Dctmain, Dctust] i razli¢itih fontova i mapa fontova [Fontalt]. U poglavlju 10
naci Cete viSe detalja o ovome.

PRINT FILE, SPOOLER, AND PROLOG SECTION NAMES

Kada koristite opciju Plot to File, datotekama moZete dati imena drugacija od standard-
nih koje dodeljuje AutoCAD. Opcija Spooler defini$e aplikaciju koja treba da procita i
Stampa tako napravljenu datoteku. Opcija Prolog se odnosi na izvoz PostScript datoteka.
Ona omogucava da definiSete odeljak Prolog u datoteciAcad . psf koji AutoCAD treba da
izveze zajedno s datotekama u formatu Encapsulated PostScript. U dodatku B i poglavlju
19 govori se vise o izvozu PostScript datoteka i o datoteciAcad. psf [Psprolog].

PRINTER SUPPORT FILE PATH

Postoji nekoliko datoteka podrske povezanih sa AutoCAD-ovim sistemom za Stampanje
na ploteru i Stampacu. Ova stavka omogucava da zadate gde ¢e AutoCAD traZiti te
datoteke.

AUTOMATIC SAVE FILE LOCATION
Ovom stavkom zadajete poloZaj AutoCAD-ove datoteke Automatic Save [Savefilepath].

COLOR BOOK LOCATION

Ova stavka omogucava da zadate lokacije za katalog boja PANTONE. Katalog moZete
naknadno da instalirate s kompakt diska AutoCAD-a 2006, ako ga niste instalirali s pro-
gramom.
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DATA SOURCES LOCATION
Omogucava da definiSete poloZaj ODBC (Open Database Connectivity) Data Link dato-
teka koje se koriste za povezivanje AutoCAD-ovih crteza s datotekama baze podataka.

TEMPLATE SETTINGS

Kada izaberete opciju Use a Template iz okvira za dijalog Create New Drawing, AutoCAD
iz ovog parametra traZi lokaciju datoteke sa $ablonima. Podrazumevani parametar
moZete da izmenite, ali to verovatno nece biti potrebno.

TooL PALETTES FILE LOCATION
Omogucava da zadate lokaciju za izvorne datoteke paleta alatki koje ste sami napravili.
Kada pravite palete, AutoCAD ¢e podatke o tim paletama smestiti na zadatu lokaciju.

LoG FILE LOCATION
Pomocu ove opcije zadajete mesto na koje ¢e biti smestene datoteke evidencija [Logfile-
path].

PLOT AND PUBLISH LOG FILE LOCATION
Pomocu ove opcije zadajete mesto na koje ce biti smeStene datoteke evidencija Plot i
Publish [Logfilepath].

TEMPORARY DRAWING FILE LOCATION

AutoCAD pravi privremene datoteke da bi cuvao delove crteZa dok radite na njemu.
Obic¢no ne treba da brinete o priviemenim datotekama, sem ako po¢nu da se gomilaju na
disku ili ako radite s vrlo velikom datotekom na sistemu s malo memorije. Pomocu ove
opcije moZete da odredite mesto za privremene datoteke. Standardna lokacija je direk-
torijum C: \Documents and Settings\korisnic¢ko ime\Local Settings\Temp.
Korisniéko ime je ono pod kojim se prijavljujete na sistem. Ukoliko imate brz disk

s dosta slobodnog prostora, iskoristite ovu opciju da biste na njega smestili priviemene
datoteke i tako poboljsali performanse [Tempprefix, read-only].

TEMPORARY EXTERNAL REFERENCE FILE LOCATION

Da bi neki drugi korisnik iz mreZe mogao da otvori Xref datoteku ili datoteku na kojoj
radite, s padajuce liste Demand Load Xrefs na kartici Open And Save moZete izabrati
Enabled with Copy. AutoCAD ¢e praviti i koristiti kopije bilo koje ucitane Xref datoteke
tako da originalnu datoteku mogu otvoriti i drugi. Stavka Temporary External Reference
File Location omogucava definisanje direktorijuma u kome AutoCAD cuva kopiju Xref
datoteke [Xloadpath].

TEXTURE MAPS SEARCH PATH

Omogucava da zadate lokaciju za AutoCAD-ove mape tekstura koje se koriste u realistic-
nim prikazima. U ved¢ini slucajeva, te parametre necete morati da menjate. Ipak, mozZete
dodati direktorijum za mape tekstura koje ste dobili ili napravili.
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I-DROP ASSOCIATED FILE LOCATION

Pomocu ove opcije zadacete lokaciju za datoteke koje uvozite na ra¢unar koristeci Auto-
CAD-ovu funkciju i-drop. Nijedna lokacija nije podrazumevano navedena, pa se . DWG
datoteke uvezene pomocu i-dropa smestaju u isti direktorijum u kome se nalazi aktu-
elni crtez.

NAPOMENA Dok je AutoCAD otvoren, lako cete saznati lokaciju izvora, kao Sto je datoteka
evidencije ili datoteka automatskog snimanja. Iskoristite funkciju AutoLISP Getvar uz ime
sistemske promenljive povezane sa izvorom. Na primer, da biste brzo pronasli lokaciju dato-
teke evidencije, unesite (getvar "logfilepath”).). Za automatsko zapisivanje datoteke unesite
(getvar "savefilepath").. Korisnici LT-a mogu da iskoriste komandu Modemacro, na primer,
Modemacro.! $(getvar,logfilepath). ili Modemacro.! $(getvar,savefilepath).\. Vise podataka
0 komandi Modemacro pronaci cete u poglavlju 26.

Kartica Display

Parametri sa ove kartice omogucavaju da upravljate izgledom AutoCAD-ovog prozora.
Pomocu ovih parametara moZete zadati da AutoCAD-ov prozor izgleda potpuno dru-
gacije. MoZete da promenite trake za pomeranje sadrZaja, fontove i boje.

I
Current profile: <<Unnamed Profile>> Cuarent drawing, Drawingl.dwg

Files  TEPIEF Open and Save | Plot and Publish | System | User Prefersnces | Dratting| Selection| Profies |

" WindowElements ———| [ Display resolution
[¥ Display scroll bars in drawing window 1000 e and circle smosthness
I~ Display screen meny
I Use large buttans for Toolbars N S apH P eEe
" Show ToalTips 05 Fiendered object smaathress
¥ Show shortcut keys in ToolTips

B [ Contout lines per surfacs
Colars... Eonts... B = ?

Lapout elemen | Display perfomance
[V Display Layout and Modsl tabs I~ Pan and z00m with 1aster & OLE
[V Display printable area ¥ Highiight raster image frame orly
¥ Display paper background 5 ¥ Apply solid il

¥ Display papgr shadow I Show tet bounda frame only

I~ Show Page Setup Managst for new layouts I~ Show sihousttes in wirsframe:

[¥ Create viewpart in new layouts

Crosshair size Rieference Edit fading intensity
[ 5 A ‘ [ 50 ] E—
ok | cencel | s | hen |

GRUPA WINDOW ELEMENTS

Ove opcije kontrolisu opste parametre AutoCAD-ovog prozora:
Display scroll bars in drawing window Ukljucuje i iskljucuje trake za pomeranje
sadrzaja. Ako imate mali monitor s niskom rezolucijom, iskljucite ih da biste povecali
prostor za crtanje.
Display screen menu Ukljucuje stari meni AutoCAD Format Screen koji se ranije
nalazio na desnom kraju ekrana. Ako vam je zaista potreban, ovde cete ga ukljuciti.
Use large buttons for Toolbars Zadaje dali ¢e se na paletama alatki koristiti velike
ikonice dugmadi.
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Show ToolTips Zadaje da li ¢e se, kada pokaziva¢ misa zadrzite na alatki, pojaviti
njen opis (engl. tooltip).

Show shortcut keys in ToolTips Zadaje dali ¢e se u opisu alatke videti i njena pre-
Cica sa tastature.

Colors Otvara okvir za dijalog u kome moZete da zadajete boje raznim komponen-
tama AutoCAD-ovog prozora. Ako vam crna ne odgovara, ovde moZete da promenite
boju povrsine za crtanje.

Fonts Otvara okvir za dijalog u kome birate fontove za AutoCAD-ov prozor. MoZete
da birate iz standardne grupe Windowsovih fontova dostupnih na vasem sistemu.

GRUPA DISPLAY RESOLUTION
Pomocu ovih opcija odredujete kako c¢e objekti u AutoCAD-u biti prikazani. Sami odlu-
Cujete hocete li dati prednost preciznom prikazivanju ili brzini.

Arc and circle smoothness Odreduje izgled lukova i krugova, pogotovo kada ih uve-
cate. U nekim slucajevima, lukovi i krugovi izgledaju kao mnogouglovi (iako ¢e na
ploteru biti iscrtani kao lukovi i krugovi). Ukoliko hocete da lukovi i krugovi budu zao-
bljeniji, povecajte vrednost ovog parametra. Time Ce se povecavati i koli¢ina memorije
koja se koristi. Ovim parametrima upravlja i sistemska promenljiva Viewres [Viewres].

Segments in a polyline curve Odreduje zaobljavanje sloZenih linija. Sto je vrednost
veca, linije e izgledati zaobljenije. Ako smanjite broj, iscrtavanje ce biti brze. Ovim
parametrima upravlja i sistemska promenljiva Splinesegs [Splinesegs].

Rendered object smoothness Odreduje izgled zakrivljenih punih tela kada ih reali-
sticno prikazujete i sencite. Vrednost promenljive moZe da se krec¢e od 0,01 do 10
[Facetres].

Contour lines per surface Omogucava da definiSete broj linija konture kojima se
predstavljaju pune zakrivljene povrsine. Vrednost se krece od 0 do 2047 [Isolines].

GRUPA LAYOUT ELEMENTS

Ove opcije reguliSu nacin prikazivanja elemenata crteza u reZimu Paper Space Layout,
i detaljnije su objasnjene u poglavljima 8 i 16. Funkcionisanje veéine ovih opcija je oci-
gledno. Opcija Show Page Setup Manager for new layouts otvara okvir za dijalog pri
prvom otvaranju elemenata. Opcija Create viewport in new layouts automatski pravi
prikaz u postavci elemenata kada se ona prvi put otvori.

GRUPA DISPLAY PERFORMANCE
Opcije ove grupe omogucavaju da podesite parametre i prikaz.

Pan and zoom with raster & OLE ReguliSe nacin na koji rasterske slike reaguju
na pomeranje i zumiranje. Ako je ova opcija izabrana, rasterske slike se pomeraju
s kursorom. Iskljucite ovu opciju radi boljeg u¢inka [Rtdisplay].

Highlight raster image frame only Odreduje kako e rasterska slika izgledati kada
je izabrana. Ukljucite je radi $to boljeg ucinka [Imagehlt].

Apply solid fill Upravlja izgledom popunjenih objekata kao §to su debele sloZene
linije i povrS§ine popunjene punom Srafurom. Ovom opcijom upravlja i sistemska
promenljiva Fillmode. Vi§e o popunjenim sloZenim linijama i punim Srafurama naci
cete u poglavlju 18. Iskljucite ovu opciju radi boljeg u¢inka [Fillmode].
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Show text boundary frame only PodeSava nacin prikazivanja teksta. Ukljucite ovu
opciju da biste tekst zamenili pravougaonicima ¢ije dimenzije priblizno odgovaraju
veli¢ini prvobitnog teksta [Qtextmode].

Show silhouettes in wireframe Odreduje da li ¢e biti prikazane povrsinske mreze
modela punih tela. Iskljucite ovu opciju radi boljeg uc¢inka [Dispsilh].

KLizAC CROSSHAIR SIZE

Klizacem se reguliSe veli¢ina kursora koncanice. Ovu vrednost moZzete podesiti na 100
procenata da biste dobili kursor koncanicu preko celog ekrana, kao u starijim verzijama
AutoCAD-a [Cursorsize].

KLiZAC REFERENCE EDIT FADING INTENSITY
Regulie izgled objekata koji nisu izabrani tokom dorade referenci. U poglavlju 7 naci
Cete viSe detalja 0 menjanju referenci [Xfadectl].

Kartica Open And Save

Na kartici Open And Save nalaze se opSte opcije za rad s datotekama, kao $to su auto-
matsko snimanje i standardni format datoteke crteZa za komande Save i Save As.

Curnrent prafile; <¢Unnamed Prafilex» Current drawing: Drawingl.dwg
Files | Display {TF | Plot and Publish | & ystem| User Freferences | Drating| Selection| Profies|
i File Save 1 File Open
Save as: El Number of recentl-used files ta list
[AutaCAD 2004 Drawing [+ dwg) =l
¥ Display full path in title
Thumbnail Preview Settings.. |
~ External Reterences [<refs)
50 Inciementsl save percantags b el e
|Enabled vith copy |
~File Safety Precautions I Rietain changes to Kref lapers
¥ Automatic save I Allow other users to Refedit current drawing
10 Minutes between saves
1~ Dbject&F> Appli
¥ Create backup copy with each save o = T dpE:m:HX
I Fullting CAC validation oo Ry e
™ Maintain a log file IUb\ect detect and command inwoke j
ach File extension for temparary files Prosy images for custom objects:
IShow prowy araphics -
Security Options.
™ Show Proxy Information dislog box
[V Display digital signature information
ok I Cancel Apply Help

GRUPA FILE SAVE
Koristeci opcije iz ove grupe moZete da zadate kako ¢e AutoCAD ¢uvati datoteke.

Saveas Padajucalista omogucava da definiSete standardni format datoteke za opcije
File > Save i File > Save As. Na primer, ako radite u okruzenju u kome morate da kori-
stite datoteke AutoCAD-a 14 kao standardne, pomocu ove opcije izaberite Release

14 kao standardni tip datoteke. AutoCAD takode moZete podesiti da datoteke stan-
dardno ¢uva u DXF formatu.
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Thumbnail preview settings Omogucava da zadate da li ¢e uz crtez biti sacuvan i
njegov umanjen prikaz. Ove umanjene slike koriste se u okviru za dijalog AutoCAD
File i u DesignCenteru da biste videli datoteku pre nego $to je otvorite [Rasterpre-
view]. Takode moZete da podesavate i prikaz skupa listova [Updatethumbnail].

Incremental save percentage ReguliSe delimic¢no zapisivanje datoteka (funkcija
Incremental Save) svaki put kada izaberete opcije File > Save ili File > Save As. Deli-
mic¢no zapisivanje datoteka skracuje vreme snimanja datoteke na disk ali takode
povecava datoteku. Ako nemate mnogo prostora na disku, vrednost ove opcije pode-
site na 25. Vrednost 0 potpuno iskljucuje funkciju delimi¢nog snimanja, ali pogorSava
AutoCAD-ove performanse. Ovom opcijom se upravlja i preko sistemske promenljive
Isavepercent [Isavepercent].

GRUPA FILE SAFETY PRECAUTIONS
Ove opcije zadaju osobine automatskog snimanja rezervnih datoteka u AutoCAD-u.

Automatic save Omogucava da upravljate funkcijom Automatic Save. MoZete da je
iskljucite, ukljucite ili da podesite ucestalost snimanja datoteke unoSenjem vrednosti
u polje Minutes between saves. Putanju na kojoj se zapisuju datoteke podesite kori-
steci stavku Automatic Save File Location na kartici Files, okvira za dijalog Options.
Ucestalost automatskog snimanja podeSavate i preko sistemske promenljive Save-
time [Savefilepath, Savefile].

Create backup copy with each save Omogucava da odredite da li ¢e datoteka .BAK
biti snimljena svaki put kada snimite datoteku. Ako Zelite da sacuvate prostor na
disku, bilo bi dobro da iskljucite ovu opciju. MoZete je ukljuciti i iskljuciti preko
sistemske promenljive Isavebak [Isavebak, Tempprefix].

Full-time CRC validation Proverava celovitost svakog objekta nastalog u AutoCAD-u.
(CRC su pocetna slova od Cyclic Redundancy Check - ciklicna dodatna provera). MoZe
da se koristi kao pomo¢ pri reSavanju problema, da se ukljuci kada se sumnja na pro-
blem s hardverom ili AutoCAD-om.

Maintain alog file Omogucava da zabelezite podatke u AutoCAD-ovom prozoru za
tekst. Ova osobina je detaljnije opisana u poglavlju 19. Mesto za smeStanje datoteka
za evidenciju moZete da odredite na kartici Files okvira za dijalog Options [Logfile-
mode, Logfilename].

File extension for temporary files Omogucava da zadate oznaku tipa AutoCAD-ovih
privremenih datoteka. Te datoteke AutoCAD koristi za privremeno ¢uvanje podataka iz
crteza, za slucaj da ostane bez memorije. Ukoliko ste na mreZi, priviemene datoteke
raznih korisnika mogu da budu smestene u istom direktorijumu. Da biste znali koje su
datoteke vaSe, promenite ovaj parametar.

Security Options Otvara istoimeni okvir za dijalog u kom datoteku moZete zastititi
lozinkom ili joj dodati digitalni potpis. U poglavlju 27 detaljnije se govori o ovim
funkcijama.

Display digital signature information Prilikom otvaranja datoteke sa digitalnim
potpisom, ova opcija ¢e vas upozoriti na prisustvo digitalnog potpisa [Sigwarn].

U poglavlju 27 naci cete viSe podataka o digitalnim potpisima.
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GRUPA FILE OPEN
Pomocu ovih opcija pode3avate kako da AutoCAD prikazuje imena datoteka u meniju
File ili na naslovnoj traci crteza.

Number of recently-used files to list U ovom polju za unos moZete zadati broj dato-
teka koje ce biti prikazane u listi nedavno koris¢enih datoteka u meniju File. Una-
pred podeSena vrednost je 4, a moZete uneti vrednosti izmedu 01 9.

Display full path in title Pomocu ove opcije odredujete da li je i putanja uklju¢ena
u ime crteZa prikazanog na naslovnoj traci.

GRUPA EXTERNAL REFERENCES (XREFS)
Ove opcije omogucavaju da upravljate osobinama memorije i slojeva Xref datoteka.

Demand load Xrefs Omogucava da ukljucite funkciju Demand load Xrefs. Ta funk-
cija poboljsava performanse datoteka koje koriste Xref datoteke ucitavajuci samo
one delove Xref crteZa koji su neophodni u teku¢em otvorenom crtezu. Ova opcija
sadrZi tri podopcije: Disabled, iskljucuje funkciju; Enabled, ukljucuje funkciju; Ena-
bled with Copy ukljucuje funkciju Demand load Xrefs koristeci kopiju izvorne Xref
datoteke. Poslednja opcija omogucava da i ostali koji rade na mreZi doraduju izvornu
Xref datoteku dok vi radite na datoteci koja takode koristi tu Xref datoteku [Xloadctl].

Retain changes to Xref layers Omogucava da snimite parametre sloja Xref datoteka
na tekucem crteZu, a da to ne utice na izvornu Xref datoteku. Kada je ovaj parametar
iskljucen, tekuca datoteka uvozi parametre sloja Xref datoteke prilikom ucitavanja te
datoteke. Ovaj parametar moZete da definiSete i sistemskom promenljivom Visretain
[Visretain].

Allow other users to Refedit current drawings Pomocu ove opcije odredujete da li
ostali mogu istovremeno da doraduju datoteku koju vi doradujete. Ova opcija omo-
gucava da i drugi koriste opciju Modify > In-Place Xref and Block Editing (komanda
Refedit) pri radu s datotekama koje ste ucitali u AutoCAD [Xedit].

GRUPA OBJECT ARX APPLICATIONS

AutoCAD omogucava da korisnici ili nezavisni proizvodaci aplikacija prave objekte za
¢iju je podrsku najcesce potrebna posebna ObjectARX aplikacija. Ove opcije odreduju
kako ¢e AutoCAD tretirati takve objekte i ObjectARX aplikacije koje su s njima u vezi.

Demand load ObjectARX apps DefiniSe kada ce aplikacija nezavisnog proizvodaca
biti u¢itana ako u datoteci postoji objekat kome je potrebna. Ova opcija nudi nekoliko
parametara dostupnih s padajuce liste. Parametri su: Disable Load on Demand,
Custom Object Detect, Command Invoke i Object Detect and Command Invoke.

Prvi parametar spre¢ava AutoCAD da ucita aplikacije drugih proizvodaca ako postoji
objekat kome su neophodne. Neke standardne AutoCAD-ove komande nece raditi
ako izaberete opciju Disable Load on Demand zato §to AutoCAD koristi ObjectARX
aplikacije. Drugi parametar ¢ini da AutoCAD automatski uc¢ita ARX aplikaciju. Treci
parametar ucitava aplikaciju kada pozovete neku komandu te aplikacije. Cetvrti para-
metar ucitava ARX aplikaciju ako postoji objekat kome je potrebna ili kada pozovete
neku komandu te aplikacije [Demandload].
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Proxy images for custom objects Nudi padajucu listu na kojoj se nalaze tri parame-
tra koja upravljaju prikazom objekata kada u sistemu ne postoje ARX aplikacije koje
ih podrzavaju. Parametar Do Not Show Proxy Graphics iskljucuje prikazivanje takvih
objekata. Parametar Show Proxy Graphics prikazuje takav objekat. Parametar Show
Proxy Bounding Box umesto prilagodenog objekta prikazuje granice tog objekta.
Show Proxy Information dialog box Omogucava da izaberete da li ¢e se pojavljivati
upozoravajuci okvir za dijalog Show Proxy Information. Ako je ova opcija izabrana,
upozorenje Show Proxy Information pojavljuje se kada otvorite crteZ s prilagodenim
objektima, a AutoCAD ne moZe da pronade objekte povezane sa ARX aplikacijom
[Proxynotice].

Kartica Plot and Publish
Kartica Plot and Publish okvira za dijalog Options nudi parametre za podeSavanje Stam-
panja na ploteru i Stampacu. Opis ovih opcija pronaci ¢ete u poglavlju 8 i u dodatku B.

Kartica System
Opcije s kartice System upravljaju nekim parametrima glavnog AutoCAD-ovog inter-
fejsa, kao §to su upravljacki programi za prikazivanje i pokazivacki uredaji.

Curnrent prafile; <¢Unnamed Prafilex» Current drawing: Drawingl.dwg

&1 Preferences | Drafting| S slection | Profiles |

Files | Display| Open and Save | Plot and Publish |

GSHEIDO i Properties...

"Eunam 30 Graphics Display

- General Options
I~ Single-diawing compatibility mode:
IV Display OLE Test Size Dislag

i~ Current Pointing Device

IEunent Spstem Pointing Device j
Accept input fram:

1 Digitieer oy

& Digitizer and movse.

I¥ | Show all waming messages

™ Beep on enor in user input

™ Load acad lsp with every drawing
[V Allow long syrbal names

Startup: IDD nat show a startup dialog

i~ Layout Regen Dptions
" Begen when switching layouts
" Cache mode! tab and last lagout

& Cache model tab and all lapouts

[~ Live Enabler Dptions

[~ Check Web for Live Enablers

5 taximurm number of unsuccesstul checks

i~ dbConnect Options
¥ Store Links indey in drawing file
[~ Open tables in read-only mode

oK I Cancel Epply

Help

GRUPA CURRENT 3D GRAPHICS DISPLAY

Ova grupa sadrzi padajucu listu i dugme Properties. Padajuca lista nudi sve dostupne
sisteme za prikazivanje 3D grafike. Standardna opcija, GSHEIDI10, Autodeskov je sistem
za prikazivanje 3D grafike Heidi 3D Graphics. Ostale stavke moZete da kupite od nezavi-
snih proizvodaca.



1010 DODATAK A INSTALIRANJE | PODESAVANJE AUTOCAD-A

Dugme Properties otvara okvir za dijalog 3D Graphics System Configuration s dodat-
nim opcijama pomocu kojih moZete upravljati alatkama 3D Orbit i Shade Mode. Opcije
ovog okvira za dijalog razlikovace se u zavisnosti od toga koja je stavka izabrana na pada-
jucoj listi. Ako koristite standardni sistem za prikazivanje, GSHEIDI10, pogledajte odeljak
Podesavanje AutoCAD-ovog sistema za 3D grafiku, u ovom dodatku.

GRUPA CURRENT POINTING DEVICE
Preko opcija ove grupe moZete da izaberete vrstu pokazivackog uredaja koji ¢ete kori-
stiti u AutoCAD-u. Padajuca lista nudi opcije Current System Pointing Device i Wintab
Compatible Digitizer. Ako hocete da koristite standardni Windowsov pokazivacki uredaj,
izaberite opciju Current System Pointing Device. Ukoliko upotrebljavate tablu za digita-
lizaciju koja koristi upravljacki program Wintab, izaberite opciju Wintab Compatible
Digitizer.

Ako cete u AutoCAD-u koristiti samo table za digitalizaciju, morate to dodatno potvr-
diti izborom radio-dugmeta Digitizer only. Ukoliko izaberete radio-dugme Digitizer and
mouse, AutoCAD ¢e prihvatati oba uredaja.

GRUPA LAYOUT REGEN OPTIONS
Ovim skupom radio-dugmadi odredujete kako se regeneriSe crteZ prikazan na karti-
cama Layout.

Regen when switching layouts Zadajete AutoCAD-u da regeneriSe crtez kada izabe-
rete karticu Layout ili Model. Koristite ovu opciju ako nemate dovoljno radne memo-
rije u racunaru.

Cache model tab and last layout Birate opciju koja ne regenerise crtez kada prela-
zite iz rezima Model u rezZim Layout u kome ste poslednji put radili. Ako izaberete
neku drugu karticu rezima Layout, crteZ ¢e biti regenerisan.

Cache model tab and all layouts Birate opciju koja ne regeneriSe crtez, u kom god
rezimu radili.

GRUPA DBCONNECT OPTIONS
Ova polja za potvrdu omogucavaju da upravljate funkcijom dbConnect.

Store Links index in drawing file Omogucava da izaberete gde ce biti sacuvani
podaci za vezu s bazom podataka. Ako je ova opcija potvrdena, podaci veze se cuvaju
na crtezu koji je povezan s bazom podataka. Ovim se povecava datoteka i produzava
njeno ucitavanje.

Open tables in read-only mode Omogucava da ogranicite pristup datotekama baze
podataka.

GRUPA GENERAL OPTIONS
Ovaj skup polja za potvrdu omogucava da definiSete opcije u vezi sa opStim operaci-
jama AutoCAD-a.

Single-drawing compatibility mode Omogucava da odredite hoce li vam AutoCAD
dozvoliti da otvorite viSe dokumenata ili ¢e vas ograniciti na samo jedan, kao u pret-
hodnim verzijama AutoCAD-a [Sdi].
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Display OLE Text Size Dialog Omogucava da definiSete prikazivanje okvira za dijalog
OLE Text Size. Taj okvir za dijalog se obi¢no pojavljuje kada tekstualne OLE objekte u
AutoCAD-ov crtez umetnete komandom Edit > Paste.

Show all warning messages Ako pomocu opcije Don't Display This Warning Again
iskljucite poruku upozorenja, ova opcija omogucava da ponovo aktivirate sve takve
poruke. Ukoliko nijedna poruka upozorenja nije iskljucena, ova opcija je neaktivna.

Beep on error in user input Ukljucuje zvucni signal svaki put kada program detek-
tuje gresku u ulaznim podacima.

Load Acad.lsp with every drawing Odreduje dali e datotekaAcad. 1sp biti ucitana
sa svakim crtezom. Ako ste navikli da datoteku Acad. 1sp koristite sa AutoCAD-om,
izaberite ovu opciju; u suprotnom, AutoCAD ce ucitati samo datotekuAcaddoc.1sp
[Acadlspasdoc].

Allow long symbol names Omogucava da stavkama kao $to su slojevi, blokovi, tipovi
linija i imena stilova teksta date duga imena. Kada je ova opcija uklju¢ena, moZete da
unesete ime koje se sastoji od najvise 255 znakova [Extnames].

Startup U ovoj padajucoj listi moZete da definiSete da li ¢e AutoCAD pri prvom pokre-
tanju prikazati okvir za dijalog AutoCAD Startup i da li e se, kada odaberete File >
New, otvarati okvir za dijalog Create New Drawing. Ako je odabrana opcija Show Star-
tup Dialog Box, ovi okviri za dijalog ¢e se pojavljivati. Ukoliko nije, AutoCAD ce auto-
matski otvarati podrazumevani prazan dokument na osnovu poslednje datoteke
$ablona koja je koriS¢ena, a kada odaberete File > New, pojavljivace se okvir za dijalog
Select Template.

GRUPA LIVE ENABLER OPTIONS
Od verzije AutoCAD 14, nezavisni proizvodaci imaju moguénost da stvaraju objekte
poznate kao proxy objects koriste¢i alatku za programiranje ObjectARX. Kada je ta novina
uvedena, morali ste da imate instaliranu aplikaciju nezavisnog proizvodaca ako ste hteli
da pregledate ili menjate objekte nastale kori§¢enjem takve aplikacije. Pod pojmom
object enablers podrazumevamo male programe, AutoCAD-ove dodatke, pomocu kojih
moZete pregledati ili menjati objekte nastale pomocu aplikacija nezavisnih proizvodaca
iako niste celu aplikaciju nezavisnog proizvodaca instalirali na racunar.

Ovakvi programi se nalaze na Webu i, ako je to dozvolio proizvodac, moZete ih bes-
platno preuzeti.

Check Web for Live Enablers Ako izaberete ovu opciju, AutoCAD ¢e na Internetu
potraziti programe za rad sa objektima nezavisnih proizvodaca. Na primer, ako ste
primili datoteku napravljenu u Architectural Desktopu koja sadrZi takav objekat,
AutoCAD se automatski povezuje sa Autodeskovom Web stranicom i preuzima Archi-
tectural Desktop Object Enabler, tako da moZete menjati i pregledati datoteku. Opcije
Live Enabler omogucavaju da kontrolisete kako se programi tipa Object Enabler kori-
ste ako AutoCAD naide na objekte nastale pomocu aplikacija nezavisnih proizvodaca.

Maximum number of unsuccessful checks Pomocu ove opcije definiSete koliko ce
puta AutoCAD pokusati da se poveZe sa Internetom ako je prvi pokusaj povezivanja
bio neuspesan.

1011
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Kartica User Preferences

Opcije kartice User Preferences omogucavaju da podesite na koji nacin ¢e AutoCAD rea-

gOVﬁtl na unose.
Curent profile: <<Unnamed Prafile>> Current drawing; Drawing].dwg

Files I D\splayl Open and Savel Plat and Publishl Spstemn  User Preferences |Dralt\ng| Selecl\onl F‘rul\\esl

[~ Windows Standard Behavior————————————— [~ Priority for Coardinate DataEntry ————————————————
¥ Shortcut menus in drawing area " Running obisct snap
" Keyboard entry
Right-click Customization. ..

£+ Keyboard entry except scripts

r~ Insertion scale ~Associative Dimensioning
Default settings when units are set to unitless:

[¥ Make new dimensions associative
Source content units:

Inches =

[~ Hyperlink
IErEidE ¥ Display hyperlink. cursor, taolip, and shortcut menu
Inches =
i Fields [~ Undo/Redo

¥ Display background of fields

Eield Update Settings...

Hidden Line Settings... | Lineweight S ettings.... | Edit Scale List... |

¥ Combine zoom and pan commands

K | Cancel Aoply I

GRUPA WINDOWS STANDARD BEHAVIOR

Ovi parametri omogucavaju da odredite kako ¢e se AutoCAD ponasati kada pritisnete
tastersku kombinaciju ili desni taster misa.

Shortcut menus in drawing area Kada pritisnete desni taster misa, a ukljucena je
ova opcija, pojavice se priru¢ni meni. Ako nije potvrdena, AutoCAD pritisak na desni
taster misa tretira kao pritiskanje tastera Enter [Shortcutmenu].

Right-click Customization Otvara istoimeni okvir za dijalog, koji nudi jo$ opcija za
podesavanje funkcija desnog tastera misa u AutoCAD-u.

[P Right-click Customization x|

I~ {m on fime-sensitive night-clicks
Quick. click for ENTER

Longer click to display Shortcut Menu

Langer click duration: | 2501 miliseconds

Default Made
If no objects are selected, right-click means
" Repeat Last Command
& Shartcut Menu

~ Edit Made
If one or mare objects are selected, right-click means
" Repeat Last Command
& Shartout Menu

1~ Command Mods
I & command is in progress. right-click means

" ENTER
" Shartout Menu: ahways enabled

% Shortcut Menu: enabled when command options are present

Apply & Close I Cancel Help
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Opcija Turn on time-sensitive right-click odreduje kako ¢e AutoCAD reagovati kada
korisnik brzo pritisne desni taster misa, ili ga na trenutak drzi pritisnutog. Ukoliko je ova
opcija potvrdena, kratak pritisak na desni taster miSa bice isto Sto i pritisak na taster
Enter. Ako taster duZe drZite pritisnut, pojavice se priru¢ni meni. MoZete podesiti i pot-
rebno trajanje pritiska na desni taster misa.

GRUPA INSERTION SCALE

Pomocu ovih parametara pode$avate nacin na koji DesignCenter ili funkcija i-drop
odreduju razmeru blokova kada im se dodele merne jedinice za DesignCenter. Svaka
padajuca lista nudi standardni skup jedinica dostupnih u padajucoj listi Insert Units
okvira za dijalog Block Definition. O blokovima sam govorio u poglavlju 7, a u poglavlju
27 o opciji DesignCenter [Insunits].

GRUPA FIELDS

Parametri u ovoj grupi omogucavaju upravljanje prikazom i osveZavanjem polja. Opci-
jom Display background of fields ukljucujete prikaz sive pozadine polja. Ta pozadina
omogucava da na prvi pogled na crtezu vidite koji su tekstualni objekti polja. Pozadina
nece biti odStampana. Ako pritisnete dugme Field Update Settings, otvorice se okvir za
dijalog u kom moZete izabrati akciju za aZuriranje polja.

PRIORITY FOR COORDINATE DATA ENTRY
Pomocu ovih opcija odredujete na koji nacin AutoCAD odgovara na unos koordinata.

Running object snap Zadaje da AutoCAD sve vreme koristi aktivne Osnape [Osnap-
coord].

Keyboard entry Omogucava da koristite tastaturu za unos koordinata.

Keyboard entry except scripts Omogucava da koordinate unesete preko tastature,
osim u makroima [Osnapcoord].

GRUPA ASSOCIATIVE DIMENSIONING

U ovom delu imate jednu opciju, Make New Dimensions Associative, koju moZete ili
iskljuciti ili ukljuciti. Njom definiSete da li ¢e AutoCAD koristiti moguénosti asocijativ-
nog kotiranja koja je uvedena u verziji 2002. Asocijativno kotiranje omogucava da kote
prate promene objekta. Kada koristite staru metodu, morate ukljuciti i tacku definisanja
dok menjate objekat ako hocete da kote prate promene objekta.

GRUPA HYPERLINK
Sadrzi jednu opciju koja ukljucuje i iskljucuje prikazivanje ikonice Hyperlink i njenog
priru¢nog menija.

GRUPA UNDO/REDO
DefinisSe kako ¢e komande Undo i Redo funkcionisati s komandama Zoom i Pan.
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DUGME HIDDEN LINE SETTINGS

SAVET  Pritisnite dugme Hidden Line Settings da biste otvorili istoimeni okvir za dijalog u
kom mozete podeSavati izgled 3D prikaza sa skrivenim linijama. Opcijama iz tog okvira za
dijalog podeSavate izgled skrivenih linija u prikazu koji dobijate komandom Hide ili u prikazu
Hidden Shared. Skrivene linije su podrazumevano nevidljive, ali ih moZete prikazati u drugoj
boji ili drugim tipom linije.

U okviru za dijalog Hidden Line Settings odredujete i hoce li 3D ravni koje se seku
biti oznacene linijom. U ranijim verzijama AutoCAD-a, ravni koje se presecaju nisu bile
oznacavane, ali od verzije 2004 moZete ih obeleZiti linijom u prikazima sa skrivenim
linijama. MoZete zadati i boju linije.

DUGME LINEWEIGHT SETTINGS
Pritisnite dugme Lineweight Settings da biste otvorili istoimeni okvir za dijalog. Detalj-
nija objasnjenja ovog okvira za dijalog naci ¢ete u poglavljima 81 15.

DUGME EDIT SCALE LisT
Pritisnite dugme Edit Scale List da biste otvorili istoimeni okvir za dijalog. MoZete dodati
namenske razmere koje ¢e se potom pojavljivati u okviru za dijalog Plot.

Kartica Drafting
Kartica Drafting nudi parametre koji se odnose na kursor za crtanje, ukljucujucii opcije
AutoSnap i AutoTrack.

Curent profile: <<Unnamed Profile>> Current drawing; Drawing].dwg

Files I D\splayl Open and Savel Plat and Publlshl Systeml User Preferences  Drafting |Selecl\on| Fruh\esl

- AutaSnap Settings ~AutoTrack Settings

¥ Marker

¥ Magnet

¥ Display AutoSnap toolip

[ Display AutoSnap aperture box

AutaSnap marker color:

¥ Display polar tracking vector
¥ Display full-screen tracking vectar
¥ Display AutoTrack toolip

~Alignment Point Acquisition
% Automatic

] Calor 31 -
 Ghift to acguire
[ AutaSnhap Marker Size ~Aperture Size

1
L]

!_I_I 1]
\_'_I

i~ Object Snap Options
¥ lgnore hatch ohiects
™ ReplaceZ value with current elevation

r~ Drafting Tooltip Appearance

K Cancel Apply

Help
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GRUPA AUTOSNAP SETTINGS
Opcijama iz ove grupe upravljate osobinama AutoSnap koje su aktivne kada koristite
markere Osnap.

Marker Ukljucuje mali kvadrat koji se pojavljuje na mestu Osnapa. Ako necete da
koristite ovaj marker, ponistite potvrdu opcije Marker [Autosnap].

Magnet Cini da kursor Osnap ,skace” na mesto Osnapa prilikom pribliZavanja kur-
sora tom mestu [Autosnap].

Display AutoSnap tooltip Odreduje dali ¢e biti prikazan savet za koriScenje alatke
Osnap [Autosnap].

Display AutoSnap aperture box Prikazuje kvadrat preko kursora svaki put kada su

markeri Osnap aktivni. Ako ste koristili ranije verzije AutoCAD-a, videcete da je sim-
bol za Aperture Box onaj koji je u ranijim verzijama, pre pojavljivanja funkcije Auto-
Snap, koriscen za Osnape [Apbox].

AutoSnap marker color Omogucava da zadate boju markera AutoSnap.

KLizAC AUTOSNAP MARKER SIZE
Pomerite kliza¢ da biste zadali veli¢inu markera AutoSnap.

GRUPA AUTOTRACK SETTINGS
Pomocu ovih opcija pode3avate vektor Tracking koji se koristi za Polar Tracking i Osnap
Tracking.

Display polar tracking vector Ukljucuje i iskljucuje vektor Polar Tracking [Trackpath].

Display full-screen tracking vector Omogucava da odredite da li ¢e se vektor Trac-
king pojaviti preko celog prozora za crtanje, da li ¢e se zaustaviti na polozaju kursora
ili u preseku dva vektora Tracking [Trackpath].

Display AutoTrack tooltip Ukljucuje ili iskljucuje kratak opis alatke Osnap Tracking
[Autosnap].

GRUPA ALIGNMENT POINT ACQUISITION
Omogucava da zadate na koji nacin cete dobiti tacke ravnanja Osnap Tracking.

KLIZAC APERTURE SIZE
Pomerite kliza¢ da biste definisali veli¢inu okvira za izbor Osnap [Aperture].

GRUPA OBJECT SNAP OPTIONS

U ovoj grupi nalaze se opcije Ignore hatch objects i Replace Z vaule with current elevation.
Kada je opcija Ignore hatch objects iskljuc¢ena, objekti za koje je uklju¢eno prianjanje
pokusace da prionu uz geometriju unutar Srafure. Kada ukljucite opciju Replace Z vaule
with current elevation, AutoCAD ¢e umesto vrednosti Z ose izabrane tacke koristiti podra-
zumevanu Z vrednost tekuéeg UCS-a.
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GRUPA DRAFTING TOOLTIP APPEARANCE
Omogucava da upravljate bojom, veli¢inom i providno§¢u opisa koji se pojavljuje kada
pokazivac zadrzite na alatki.

Kartica Selection

Pomocu opcija sa ove kartice okvira za dijalog Options, zadajete nacine na koje cete
birati objekte u AutoCAD-u. MoZete podesiti i osobinu Grips.

Curnrent prafile; <¢Unnamed Prafilex» Current drawing: Drawingl.dwg

Fies | Display| Open and Save| Plot and Publish | System| User Freferences | Dralting Selection | Profies |

[~ Pickbox Size [~ Grip Size
- . —
i~ Selection Previes [~ Grips
¥ “when a command i active Unselected grip color:
¥ when no command is active I Colar 160 -
Selected grip zolor:
H Wisual Effect Settings.
[ 5 (T —
Hover grip color
[~ Selection Modes lﬁ
reen -
[V Moun/verb selection
I™ Use Shift to add to selection I Enable grips
I~ Press and drag ™ Enable grips within blocks

¥ Implied windowing W' Enable giip tips
ol A e 100 Object selection fimit for display of aiips

[~ Associative Hatch

ok | Cancdl Apply Help

KLizAC PICKBOX SIZE
Omogucava da podesite veli¢inu okvira za izbor objekata [Pickbox].

KuLizac€ GRIP SIZE
Omogucava da podesite veli¢inu rucica [Gripsize].

GRUPA SELECTION PREVIEW

Omogucava da upravljate ponasanjem prikaza izbora dok misem prelazite preko obje-
kata. Pritisnite dugme Visual Effect Settings da biste fino podesili vizuelne efekte biranja
objekata, ukljucujudi boju i linije okvira za izbor koji se automatski aktiviraju.

GRUPA SELECTION MODES

Opcije Selection Modes omogucavaju da podesavate stepen AutoCAD-ove prilagode-
nosti za rad u standardnom grafickom korisnickom okruZenju (engl. graphical user
interface, GUI).
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Noun/verb selection Pomocu ove opcije AutoCAD radi poput vecine Windowsovih
programa — dozvoljava da objekte izaberete pre nego $to odaberete akciju ili zadate
komandu [Pickfirst].

Use Shift to add to selection Ako potvrdite ovu opciju, moci ete da izaberete vise
objekata primenom standardne metode karakteristicne za GUI: objekte birate drzeci
taster Shift. Ukoliko ne drZzite taster Shift pritisnut, moZete izabrati samo jedan obje-
kat ili grupu objekata koja je obuhvacena prozorom. Kad ne drZite pritisnut taster
Shift dok birate objekte, ponistava se izbor prethodno izabranih objekata. Da biste
ovu opciju ukljucili pomocu sistemske promenljive, parametar Pickadd postavite na
0 [Pickadd].

Press and drag Ako ovu opciju potvrdite, prozore moZete da rasporedujete stan-
dardnom metodom karakteristicnom za GUI: pritisnite i drzite taster miSa na prvom
uglu prozora; zatim, drZeci i dalje taster miSa, povucite prozor na pravo mesto. Kada
je suprotan ugao na svom mestu, pustite taster miSa. Ovaj parametar se primenjuje
na module Verb/Noun i Noun/Verb. Ako radite sa sistemskom promenljivom, posta-
vite Pickdrag na 1 [Pickdrag].

Implied windowing Kada je ova opcija potvrdena, a nijedan objekat nije izabran, na
zahtevza unos Select objects prozor tipa Window ili prozor tipa Crossing se auto-
matski aktivira. Ovaj parametar ne uti¢e na parametar Noun/Verb. Za rad sa sistem-
skom promenljivom, postavite Pickauto na 1 [Pickauto].

Object grouping Omogucava da izaberete grupe kao pojedinacne objekte [Pickstyle].

Associative Hatch Omogucava da odjednom izaberete i Srafuru i njenu granicu
[Pickstyle].

GRUPA GRIPS
Pomocu ovih opcija upravljate ruc¢icama.

Unselected grip color Omogucava da izaberete boju rucica koje se vide, a nisu iza-
brane [Gripcolor].

Selected grip color Omogucava da odaberete boju izabranih rucica [Griphot].

Hover grip color Omogucava da zadate boju rucice kada se kursor nalazi iznad nje
[Griphover].

Enable grips Ukljucuje osobinu Grips.

Enable grips within blocks Ako ukljucite ovu opciju, prikazace se rucice u okviru
blokova. Iako rucice unutar blokova ne moZete da menjate, moZete da ih koristite
kao tacke za biranje [Gripblock].

Enable grip tips Ukljucuje prikazivanje opisa rucica na proizvoljnim objektima koji
ih imaju [Griptips].

Object selection limit for display of grips Upravlja prikazivanjem rucica u zavisnosti
od broja izabranih objekata. Ako je vrednost 1, rucice se nece videti kada je izabrano
viSe od jednog objekta. MoZete zadati vrednosti od 1 do 32767. Podrazumevana
vrednost je 100 [Gripobijlimit].



1018 DODATAK A INSTALIRANJE | PODESAVANJE AUTOCAD-A

Kartica Profiles

Ako koristite Windows XP Professional ili Windows 2000, znate da je profil korisnika sacu-
van za svako korisnicko ime. U zavisnosti od toga koje ime koristite za prijavljivanje,
imacete razli¢ito podeSen Windows. Kartica Profiles nudi sli¢ne funkcije za korisnike
AutoCAD-a. U profilu mozete da ¢uvate razlicite parametre iz okvira za dijalog Options

i ponovo ih pozivate. MoZete ih sacuvati i kao datoteku s nastavkom .arg i zatim takvu
datoteku preneti u drugi sistem. Ovo je kao da parametre Options nosite kud god da idete.

Current prafile: <<Unnamed Profil>» Curent drawing: Drawingl.dwa

Files | Display| Open and Save | Plot and Publish | System | User Preferences | Drating | Selection { Fiofies |

Available profiles:

<<LInnamed Frofile> > Set Current
Add to List...
Rename.
Delete
Export.
Impart...
Reset

1] I Cancel Apply Help

Glavni deo kartice Profiles daje spisak dostupnih profila. <<Unnamed Profile>> je
standardni profil. Ukoliko dodate nove profile, oni ¢e se pojaviti u spisku.

Da biste definisali nov profil, istaknite ime profila na spisku i pritisnite Add to List.
Pojavice se okvir za dijalog Add Profile u koji unosite ime i opis profila. Opis ce se poja-
viti u polju ispod spiska na kartici Profiles kad god izaberete taj profil.

Posto ste definisali nov profil, promenite parametre na ostalim karticama okvira za
dijalog Options. Novi parametri e biti povezani s novim profilom. U profilima se cuva
nacin na koji su podeSeni meniji, tako da se mogu upotrebiti kao pomo¢ pri sredivanju
Sema ili softvera drugih proizvodaca koji su vama prilagodeni. Evo kratkog opisa opcija
sa kartice Profiles:

Set Current Instalira parametre iz izabranog profila.
Add to List Pravi nov profil od postojeceg.

Rename Menja ime i opis profila.

Delete Uklanja odabrane profile iz spiska.

Export Snima profil u datoteku.

Import Ucitava profil koji je snimljen kao datoteka.

Reset Vrednosti izabranog profila vraca na standardne.
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Podesavanje menija s komandama za rad
s tablom

Da biste tablu za digitalizaciju koristili u AutoCAD-u, konfigurisite masku s menijima.
Otvorite datoteku Tablet . dwg iz direktorijuma Sample, koji se nalazi u direktorijumu
AutoCAD 2006 i odStampajte Sablon za masku s menijima koji po veli¢ini odgovara
va$oj tabli za digitalizaciju. Nakon toga ucinite sledece:

1. Dobro pri¢vrstite masku za tablu. Proverite da li maska potpuno pokriva povrsinu
za crtanje na tabli za digitalizaciju.

2. Odaberite Tools > Tablet > Configure. Pojavice se sledeci zahtev za unos:
Enter number of tablet
menus desired (0-4) <0>:
Unesite 4.1. U sledecem nizu zahteva odredicete mesto za Cetiri oblasti za menije
na tabli za crtanje pocevsi od oblasti s menijem 1 (slika A.1).

3. Pratite uputstva na komandnoj liniji.

4. Kada se pojavi zahtev za unos Do you want to respecify the Fixed Screen Pointing
Area?, upiSite Y.l i izaberite uglove koji su naznaceni u zahtevima za unos.

SLIKA A.1: 6 \
Kako da odredite OAUT O CA D ©)

mesta za oblasti s Y AUTODESK .

menijima na tabli.

AN
N Gornji levi ugao prve oblasti menija

Prva oblast menija

Donji levi ugao prve ablasti menija Donji desni ugao prve oblasti menija

AN

~

AN
N\ Gomji levi ugao druge oblasti menija Gornji desni ugao prostora
7a digitalizaciju i gornji levi
gao trece oblasti menija
Druga oblast menija Prostor za digitalizaciju Treca oblast

Donji levi ugao prostora za menija
digitalizaciju i donji desni
Y Donji levi ugao druge oblasti menija /ugao druge oblast menia
# ’
N . P
™ Gornjle ugao etvrte blsti e Donj lvi ugao trece oblast menija /. /
i Donji desni ugao
Cetvrta oblast menija trece oblasti menija

Donji levi ugao Cetvrte oblasti menija Donji desni ugao cetvrte oblasti menija
/ N\
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Ukljucivanje nacina biranja Noun/Verb

Ukoliko iz bilo kog razloga modul Noun/Verb nije dostupan, pratite sledece korake
da biste ga aktivirali:

1. Odaberite Tools > Options. Kada se pojavi okvir za dijalog Options, izaberite
karticu Selection.

2. U grupi dugmadi Selection Modes potvrdite opciju Noun/Verb Selection.
3. Pritisnite OK.

Sada bi trebalo da se vidi mali kvadrat u preseku koncanice. Taj kvadrat je okvir za
izbor (engl. pickbox) postavljen preko kursora. Obavestava vas da moZete birati objekte
¢ak i ako na zahtevu za unos na dnu ekrana nema aktivnih komandi. Kao §to ste videli
ranije, kvadrat nestaje istog trenutka kada poc¢nete da radite s komandom koja zahteva
izbor tacaka.

Modul Noun/Verb moZete aktivirati i upisivanjem 'Pickfirst.! s komandne linije. Na
zahtev za unos New value for PICKFIRST <@>:upiSite 1. (ako upiSete 0, funkcija
Pickfirst se iskljucuje). Sistemska promenljiva Pickfirst ¢uva se u AutoCAD-ovoj konfi-
guracionoj datoteci. O sistemskim promenljivama saznacete vise u dodatku C.

Aktiviranje funkcije Grips
Ako funkcija Grips iz nekog razloga nije aktivna, pratite sledece korake da biste je
aktivirali:
1. Odaberite Tools > Options, a zatim u okviru za dijalog Options izaberite karticu
Selection.
2. U grupi Grips potvrdite polje Enable Grips.
3. Pritisnite OK i spremni ste za dalji rad.

Kartica Selection okvira za dijalog Options omogucava da odredite da li se rucice
pojavljuju na objektima koji ¢ine blok (viSe o blokovima u poglavlju 4), i da zadate boju
iveli¢inu rucica. U dodatku D opisano je kako se te opcije postavljaju pomocu sistem-
skih promenljivih.

Funkciju Grips moZete aktivirati i ako upiSete ’Grips- na komandnu liniju. Na zahtev
zaunosNew value for GRIPS <@>: upiSite 1 za ukljucivanje rucica ili 0 za iskljucivanje
rucica. Sistemska promenljiva Grips ¢uva se u AutoCAD-ovoj konfiguracijskoj datoteci.

Podesavanje funkcije Tracking Vector

Ako AutoCAD ne bude prikazivao funkciju Tracking Vector kao §to je objasnjeno u rani-
jim poglavljima knjige ili ako se ona ne ponasa kako je opisano, verovatno je ova opcija
iskljucena ili promenjena. Da bi se funkcija Tracking Vector ponasala kao §to je opisano
u knjizi, preduzmite sledece korake:

1. Izaberite Tools > Options da biste otvorili okvir za dijalog Options.

2. Izaberite karticu Drafting.

3. Potvrdite sve tri opcije u grupi AutoTrack Settings.
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4. Proverite da li su u grupi AutoSnap Settings potvrdene opcije Marker, Magnet
i Display AutoSnap.

5. Proverite da li je u grupi Alignment Point Acquisition izabrano radio-dugme
Automatic.

6. Pritisnite OK da biste izasli iz ovog okvira za dijalog.

Podesavanje AutoCAD-ovog sistema
za 3D grafiku

Performanse AutoCAD-ovog sistema za 3D grafiku moZete da podesite u okviru za dija-
log 3D Graphics System Configuration. Da biste otvorili ovaj okvir za dijalog, izaberite
karticu System okvira za dijalog Options i pritisnite dugme Properties iz grupe Current
3D Graphics Display.

[falap Graphics System Configuration 2%

¥ Bdaptive degradatiod ——————— T Renderoptions ————————————————————
= Enable backgrounds
= Enabie liahts

To maintain speed, degrade to the
fallowing rendering mades:

™ Flat shaded

¥ Wireframe
[¥ Bounding box

Maintain speed: IE _Ij FPS

¥ Enable materials
™| Enghle tegtures

Transparency
£ High Huality/Slower

= Medium Gualiy
& [Low Qualty/Faster

¥ Dynamic llation [~ Geometr

Surface tessellation: [~ Isolines alwaps on top

J— ¥ Discard back faces

Lo detail High detail  Accelerati
Less memary tore memory ceeleralion
Curve tessellation:  Goftwars

 Hadware

' RO Select Driver wopengld. hdi =

Low detail High detail
Less memory More memory I™ | Use geometiy acceleration (sinale precision]

Mumber of tessellations to cache: |4 _|:jl

™| Enable anti-aliasing lines

Apply & Closel Cancel Help

Ovaj okvir za dijalog omogucava da zadate na koji ¢e na¢in AutoCAD prikazivati 3D
modele dok koristite alatku 3D Orbit ili kada radite u reZimu Shade. Sledi spisak opcija
okvira za dijalog GSHEIDI10 3D Graphics System Configuration.

Grupa Adaptive degradation

Alatka 3D Orbit omogucava da prikaz sagledavate u realnom vremenu, $to predstavlja
veliki zahtev za graficki sistem vaSeg racunara. Da bi 3D prikaz aZuriran u realnom vre-
menu bio ravnomeran, AutoCAD ce pojednostaviti prikaz tokom njegove transformacije.
Opcije iz grupe Adaptive degradation omogucavaju da zadate nivo pojednostavljivanja
prikaza dok koristite alatku 3D Orbit.
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Flat shaded Pomocu ove opcije zadajete AutoCAD-u da 3D prikaz objekta osenci
po algoritmu flat.

Wireframe Pomocu ove opcije zadajete AutoCAD-u da trodimenzionalne objekte
prikaZe kao Zi¢ane modele.

Bounding box Pomocu ove opcije zadajete AutoCAD-u da pojednostavi 3D prikaz
objekta, tako da prikazuje konturne linije koje predstavljaju objekte.

Maintain speed FPS Omogucava da za prikazivanje 3D objekata u realnom vremenu
podesite broj kadrova u sekundi. Visa vrednost zahteva bolje performanse grafickog
sistema vaSeg raCunara.

Grupa Dynamic tessellation

Opcije ove grupe odreduju glatko¢u 3D objekata prilikom senc¢enja. Da bi se simulirala
glatkoca, sistem AutoCAD Heidi 3D Graphics zaobljene povrS$ine rastavlja na trouglove.

Surface tessellation Pomocu ove opcije podeSavate koli¢inu detalja prikazanih na
povrsini. Vise detalja zahteva deljenje povrsine na viSe trouglastih povrsi, $to opet
zahteva viSe sistemske memorije.

Curve tessellation Pomocu ove opcije podeSavate koli¢inu detalja prikazanih na
zaobljenim povr§inama. ViSe detalja zahteva i deljenje na viSe trougaonih povrsina,
$to opet zahteva viSe sistemske memorije.

Number of tessellations to cache Ovom opcijom podeSavate broj trouglova koji se
smeStaju u kes. Kes je deo memorije rezervisan za ¢uvanje Cesto koriscenih podataka.
AutoCAD ce u kes uvek smestiti jedan trougao (engl. tessellation). Ako u kes memoriju
smestite dva trougla, poboljsacete izgled i performanse 3D objekata kada koristite
vie prozora za prikaz.

Grupa Render options

Ako planirate da koristite AutoCAD-ovu alatku za vizuelizaciju, sledece opcije mogu biti
korisne. Kad primenite svetla i materijale na AutoCAD-ov 3D model, pomocu ovih opcija
mozZete podesiti izgled vizuelizovane slike modela. U sluc¢aju da je va$ racunar male snage,
trebalo bi da iskljucite ove opcije posto one koriste dodatnu radnu memoriju.

Enable backgrounds Ako ste 3D modelu dodali pozadinu, ova opcija omogucava da
pozadina bude vidljiva dok menjate model.

Enable lights Ova opcija omogucava da osen¢eni 3D model bude osvetljen svetlima
koja ste definisali upotrebom komande Light ili alatke Light s palete Render. Ako niste
definisali svetla, model €e biti prikazan kao da opcija Enable Lights nije aktivirana.

Enable materials Ova opcija omogucava da izgled osencenog 3D modela bude pri-
kazan zajedno s materijalima koje ste dodelili upotrebom komande Rmat ili alatke
Materials s palete Render. Ako niste definisali materijale, model ¢e biti prikazan
uobicajeno, kao da opcija Enable Materials nije aktivirana.

Enable textures Ova opcija omogucava da se izgled osenc¢enog 3D modela prikaZze
zajedno s teksturama koje ste modelu dodelili upotrebom komandi Rmat i Setuv ili
alatke Materials s palete Render. Opcija Enable Materials mora biti aktivna da bi se
ova opcija mogla koristiti.
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Transparency Pomocu ove opcije moZete upravljati kvalitetom prikazivanja provid-
nih povrs§ina osencenog 3D modela. Birate visok (engl. high), srednji (engl. medium)
ili nizak (engl. low) kvalitet prikazivanja providnih povrsina. Nizak nivo prikazace
providne objekte sa efektom ,screen door*, dok €e srednji i visok nivo kvaliteta pri-
kazati providne objekte sa glatkijim povr§inama. Nizak nivo kvaliteta prikazivanja
omogucava brze promene prikaza.

Grupa Geometry

Pomocu ovih opcija moZete zadati da li ¢e biti prikazana pozadina povrsi i izvodnice
(Isolines) na 3D modelima.

Isolines always on top Ako koristite opciju Flat Shaded/Edges On ili Gouraud Sha-
ded/Edges On komande Shademode (View > Shade > Flat Shaded/Edges On ili View
> Shade > Gouraud Shaded/EdgesOn), izvodnice i trougaone povrs$ine bice prika-
zane. Kada je uklju¢ena opcija Isolines always on top, izvodnice i trougaone povrsine
pojavljuju se i s prednje i sa zadnje strane povrsi.

Discard back faces U vecini sistema, pri vizuelizaciji se vidi samo jedna strana
povrsine. Pozadina povrsi je nevidljiva. Ovo nije vazno za povrsi kao §to su kvadar
ili lopta gde uvek vidite samo jednu stranu; medutim, u nekim situacijama moZete
da vidite obe strane povrsi, kao $to je povrs koju koristimo kao zid.

Ako je crtez sacinjen uglavnom od zatvorenih objekata, kao $to su kvadar ili lopta, gde
inace vidite samo jednu povrs, potvrdite polje Discard back faces da biste poboljsali
performanse sistema. U slu¢aju da se mnoge povr$ine mogu videti sa obe strane,
iskljucite ovu opciju.

Grupa Acceleration
Omogucavaju da izaberete da li cete koristiti softversko ili hardversko ubrzanje pri crtanju
3D modela.

Software Pomocu ove opcije zadajete AutoCAD-u da za crtanje 3D objekata koristi
softversko ubrzanje.

Hardware Pomocu ove opcije zadajete AutoCAD-u da za crtanje 3D objekata koristi
hardversko ubrzanje kada je dostupno. Kada je ova opcija izabrana, moZete da oda-
berete upravljacki program za hardver iz padajuce liste Select Driver.

Use geometry acceleration (single precision) Cini da AutoCAD za geometriju obje-
kata koristi hardversko ubrzanje. Ova opcija je dostupna samo kada je opcija Hard-
ware izabrana, a vasa graficka kartica podrzava geometrijsko ubrzanje.

Enable anti-aliasing lines Cini da AutoCAD izgladi linije i ukloni nazubljenost linija
ilukova. Ova opcija je dostupna samo kada je opcija Hardware izabrana, a vasa gra-
ficka kartica podrzava uklanjanje nazubljenosti.



